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Release Sheet 

Carrier Electronic Catalog Customer Suite v20100205 replaces v20091218. 

SOFTWARE DESCRIPTION 

The Carrier Electronic Catalog Suite automatically installs all Carrier Electronic Catalog (E-CAT) programs using a 
single installation file.  This is an alternative to downloading and installing individual E-CAT programs one by one. 

The February 5, 2010 Electronic Catalog Suite release automatically installs the following programs: 

 X-Builder Framework v1.04c  Fan Coil Builder v3.31 
 AHUBuilder v6.03  Packaged RTU Builder v1.19q 
 Air Terminal Builder v1.09d  Self-Contained Units Builder v2.09f 
 Applied RTU Builder v2.07  Separate Sales Coil Selection v1.06 
 Commercial Split Systems Builder v1.18  Unit Ventilator Builder v1.12 

  Water Source Heat Pump Builder v4.19q 

Programs marked with the symbol  have been updated since the December 18, 2009 release. 

INSTALLATION PROCEDURES 

Installation via Internet Download 

 Download the ecat-cec20100205.exe file from the Internet site and save it in a folder on your hard disk.  Note 
that the download file is large and a fast internet connection is necessary to efficiently download this file. 

 Run Windows Explorer and double-click on the ecat-cec20100205.exe file.  This launches the program installer.  
 Follow the installation instructions that appear on your screen.  
 Note AutoDesk Volo View Express® must also be installed for certain E-CAT programs to function correctly.  

AutoDesk Volo View Express® can be downloaded from the internet site.  

Installation via E-CAT CD 

 Insert the E-CAT CD-ROM in your CD drive. 
 Run Windows Explorer and double-click on the cdsetup.exe file.  This launches the program installer.  
 Follow the installation instructions that appear on your screen.  
 Note AutoDesk Volo View Express® must also be installed for certain E-CAT programs to function correctly.  

AutoDesk Volo View Express® can be downloaded from the Carrier internet site.  

Running the Program 

Use the following procedure to run the program: 
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT/E20-II programs.  
 In the Carrier E-CAT/E20-II Programs group click Carrier Electronic Catalog v1.04c.  From Electronic Catalog 

you can run all other E-CAT programs. 

Minimum Computer Requirements: 

 Hard Disk Space: Up to 556 megabytes when installing software for the first time.  The hard disk space 
requirement is much smaller when updating existing versions of the software. 

 Random Access Memory: At least 128 megabytes (256 megabytes recommended). 
 Display Monitor: At least VGA with 600x800 resolution and 256 colors. 
 Operating System: Windows 98, 2000, XP, Vista or Windows NT (with service pack 4 or later). 
 Autodesk Volo View Express® 



 February 5, 2010  Page 2 of 2 

 

 

Carrier Software Systems 
Syracuse, NY, USA 

1-800-253-1794 
software.systems@carrier.utc.com 

 

Carrier Electronic Catalog 

Customer Suite 

Version 20100205 

Release Sheet 

INSTALLATION PROCEDURES (continued) 

Note: Certain E-CAT programs require you to install the current version of Autodesk Volo View Express® 
programs.  This program can be downloaded from the E-CAT download table on the internet site.  Volo View 
Express® (copyright Autodesk, Inc.) is freely distributed by Autodesk, Inc. as its drawing viewer. Any redistribution 
of Volo View Express® must be in compliance with the Software License Agreement that is displayed during the 
Volo View Express® installation. 

PREVIOUS VERSION INFORMATION 

If your computer contains the prior versions of the Carrier E-CAT programs, the E-CAT Suite will automatically 
replace the prior version when installed.  As a result it is not necessary for you to uninstall the prior version before 
installing the E-CAT Suite.  Exceptions only exist for a major version change or a new program and in that case the 
prior version can be uninstalled before or after installing the E-CAT Suite. 

In the February 5 Customer Suite all releases are minor program updates. 

NOTES 

1. Release Sheets.  Release sheets for individual Electronic Catalog programs are found in the "E-CAT Product 
Selection Programs" down load table on the internet site.  These sheets describe new program features. 

2. Adobe Acrobat.  Adobe Acrobat Reader v4.05 or later is required to view certified drawings in certain E-CAT 
programs.  If Acrobat Reader is not yet installed on your computer, the latest version can be downloaded from 
www.adobe.com/products/acrobat and then installed. 

http://www.adobe.com/products/acrobat


X Builder Framework

v1.04c
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Release Sheet 

X Builder Framework v1.04c replaces v1.04a 

PROGRAM DESCRIPTION 

X Builder Framework is the underlying software which serves as the “framework” tying all Electronic Catalog and 
E20-II programs together.  It can also be used as a central launch portal for all Electronic Catalog software.  The 
software appears as "Carrier Electronic Catalog" on the Start/Programs Menu. 

X Builder Framework v1.04c resolves the following issues: 
 Extraneous extraneous lines appeared in the Block Load Psychometric Graph report.  This error was introduced 

in v1.03q. 
 It was not possible to generate any Block Load reports containing graphics.  This error was introduced in v1.04a.  

Please refer to the X Builder Support Notes in the Software/Program Downloads section of the web site, or from 
Carrier Electronic Catalog’s “Welcome” screen for more information. 

INSTALLATION PROCEDURES 

Installation via Internet Download 
To perform a full program install, please use the following procedure: 
 Download the ecat-xbf104c.exe file from the internet site and save it in a folder on your hard disk. 
 Close any other programs running on your desktop computer. 
 Run Windows Explorer and double-click on the ecat-xbf104c.exe file.  This launches the program installer. 
 Follow the installation instructions, which appear on your screen.  After installation you may be asked to reboot. 

Running the Program 
Use the following procedure to run the program: 
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT/E20-II programs. 
 In the Carrier E-CAT/E20-II Programs group click on the Carrier Electronic Catalog v1.04c icon. 

Minimum Computer Requirements: 

 Hard Disk Space: 30 megabytes. 
 Random Access Memory: 128 megabytes minimum, 256 megabytes recommended. 
 Display Monitor: At least VGA with 600x800 resolution and 256 colors. 
 Operating System: Windows 98, 2000, XP, Vista or Windows NT (with service pack 4 or later) 

PREVIOUS VERSION INFORMATION 

1. X Builder Framework v1.04c will replace v1.04a automatically.  It is not necessary to uninstall v1.04a before 
installing v1.04c.  

2. X Builder Framework v1.04b was a version released to Block Load users in late December 2009 to correct the 
Block Load report problems mentioned in the Update Description section of this sheet.  This is the reason the 
version changed directly from v1.04a to v1.04c for E-CAT users. 

SPECIAL NOTES 

1. Adobe Acrobat, AutoDesk VoloView.  Certain X Builder Framework components depend on Adobe Acrobat 
Reader and Autodesk Voloview drawing viewer.  These components are included in the CD installs, but may 
need to be downloaded and installed separately if you are installing from the internet and your computer does not 
yet contain this software. 
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Carrier Electronic Catalog
AHUBuilder v6.03

Release Sheet

AHU Builder v6.03 replaces v6.02.

UPDATE DESCRIPTION

In AHUBuilder Version 6.03, the following issues were resolved:
 The Sizing Tool did not operate correctly in Metric units.
 A bug in the Fan/Coil schedule customization has been resolved.
 39M size 36 to 61 plenum fan acoustics data was incorrect. The discharge sound and casing sound results were

switched.
 DX coil calculations for R410a refrigerant did not correctly size the TXVs.
 The program allowed a 39L unit with R410a DX coils and 0.016" tubewall thickness to be configured and

indicated the unit was valid, even though this combination is not permitted.

INSTALLATION PROCEDURES

Installation via Internet Download
To perform a full program install, please use the following procedure:
 Download the ecat-sd3603.exe file from the Internet site and save it in a folder on your hard disk.
 Run Windows Explorer and double-click on the ecat-sd3603.exe file. This launches the program installer.
 Follow the installation instructions that appear on your screen.
 Note that X Builder Framework and AutoDesk Volo View Express® must also be installed for AHUBuilder to

function correctly. Both can be downloaded from the internet site.

Running the Program:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs.
 Then choose Individual Product Builders.
 Finally click on the AHUBuilder v6.03 item.

Minimum Computer Requirements:
 Hard Disk Space: 30 megabytes (for program and submittal drawing managers)
 Random Access Memory: At least 32 megabytes
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows 98, ME, 2000, XP, Vista or Windows NT (with service pack 4 or later).
 E-CAT/E20-II Configuration Services v2.1
 Autodesk Volo View Express®

Note: X-Builder Framework and Autodesk Volo View Express® programs should be installed prior to installing and
running AHU Builder. Both can be downloaded from the internet site. Volo View Express® (copyright Autodesk,
Inc.) is freely distributed by Autodesk, Inc., as its drawing viewer. Any redistribution of Volo View Express® must
be in compliance with the Software License Agreement which is displayed during the Volo View Express®
installation.

PREVIOUS VERSION INFORMATION

1. AHUBuilder v6.03 replaces v6.02 when it is installed. Therefore, it is not necessary to uninstall v6.02 before
installing v6.03.

2. Existing AHUBuilder v6.02 projects are available immediately. No data conversion is required.

3. Project data from AHUBuilder 5.90 through 5.99a can be imported into v6.03, via the “Convert from prior
version…” item on the AHUBuilder File menu.

4. Project Archives from AHUBuilder 5.90 through 5.99a can be Retrieved directly into AHUBuilder 6.03.
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SPECIAL NOTES

1. XBuilder The latest version of X Builder Framework should be installed before installing AHU Builder.

2. AutoDesk VoloView Express® must be installed in order to view DXF template drawings in the program.

3. Windows 2000 Users. When running the program on a computer using Windows 2000, on which Adobe Acrobat
Reader has not been installed, the program will be unable to display AIRManager wiring diagrams but may not
issue any error message. The solution to this problem is to download the latest version of Adobe Acrobat Reader
from www.adobe.com/products/acrobat and then install it.
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Carrier Electronic Catalog
Applied RTU Builder v2.07

Release Sheet

Applied RTU Builder v2.07 replaces Applied RTU Builder v2.06

PROGRAM DESCRIPTION

Applied RTU Builder v2.07 includes the following change:
 Added HumidiMizer option to the “P” Series.

In addition the following problems were corrected:
 When the DXF template for “A” Series size 060 with MCHX coil was selected, a “Drawing Not Found on Layer

Reference” error appeared.
 When reconfiguring a verified part number, the "Outdoor Air (Entering Outdoor Coil)" item on the Design Criteria

tab was not assigned a default value.
 After configuring a unit via the "Describe Rooftop Model" option in the Product Wizard, tag data did not

appear in the Configurator window. The Configurator window was empty.

INSTALLATION PROCEDURES

Installation via Internet Download
Use the following procedure to install the program:
 Download the ecat-rtu207.exe file from the Internet site and save it in a folder on your hard disk.
 Run Windows Explorer and double-click on the ecat-rtu207.exe file. This launches the program installer.
 Follow the installation instructions that appear on your screen.
 Note: The current version of X Builder Framework and AutoDesk VoloView Express® should be installed prior

to installing the Applied RTU Builder. Both can be downloaded from the internet site.

Running the Program
Carrier Electronic Catalog can be used to launch Applied RTU Builder. To start Electronic Catalog:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs.
 In the Carrier E-CAT and E20-II Programs group choose the Carrier Electronic Catalog item. From Electronic

Catalog you can create new or edit existing rooftop tags via the Project tab, or you can directly launch the
program via the Programs tab.

Minimum Computer Requirements:
 Hard Disk Space: 40 megabytes
 Random Access Memory: At least 256 megabytes
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows 98, 2040, XP, Vista or Windows NT (with service pack 4 or later).
 The latest X Builder Framework should be installed prior to installing the Packaged RTU Builder.
 AutoDesk VoloView Express®

AutoDesk VoloView Express® and the latest X Builder Framework should be installed before running this program.
Both can be downloaded from the internet site. VoloView Express® (copyright Autodesk, Inc.) is freely distributed
by AutoDesk Inc., as its drawing viewer. Any redistribution of VoloView Express® must be in compliance with the
Software License Agreement which is displayed during the VoloView Express® installation.

PREVIOUS VERSION INFORMATION

1. When Applied RTU Builder v2.07 is installed it will automatically replace Applied RTU Builder v2.06. There is
no need to uninstall v2.06 before installing v2.07.
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PREVIOUS VERSION INFORMATION (continued)

2. Existing projects created with Applied RTU Builder v2.06 can be used immediately in v2.07, but they will
initially contain only invalid tags. To quickly make all tags valid in the new version, highlight the project name
in the projects tree on the left and then click the “Update All Tags” button which appears at the bottom of the
right hand pane.

SPECIAL NOTES

1. XBuilder The latest version of X Builder Framework should be installed before installing Applied RTU Builder.

2. AutoDesk VoloView Express® must be installed in order to view DXF template drawings in the program.
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Carrier Electronic Catalog
Air Terminal Builder v1.09d

Release Sheet

Air Terminal Builder v1.09d replaces v1.09c

UPDATE DESCRIPTION

Air Terminal Builder v1.09d included changes that were only relevant for Carrier sales offices.

INSTALLATION PROCEDURES

Installation via Internet Download
To perform a full program install, please use the following procedure:
 Download the ecat-atb109d.exe file from the Internet site and save it in a folder on your hard disk.
 Run Windows Explorer and double-click on the ecat-atb109d.exe file. This launches the program installer.
 Follow the installation instructions which appear on your screen.
 Note that the current X Builder Framework should be installed prior to installing Air Terminal Builder. It can be

downloaded from the internet site.

Running the Program
Carrier Electronic Catalog can be used to launch Air Terminal Builder. To start Electronic Catalog:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs.
 In the Carrier E-CAT and E20-II Programs group choose the Carrier Electronic Catalog item. From Electronic

Catalog you can create new or edit existing tags via the Project tab, or you can directly launch the program via
the Programs tab.

Minimum Computer Requirements:
 Hard Disk Space: Up to 37 megabytes
 Random Access Memory: At least 64 megabytes
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows 98, 2000, XP, Vista or Windows NT (with service pack 4 or later).
 The current XBuilder Framework should be installed prior to installing the Air Terminal Builder.
 Autodesk Volo View Express®

Please note that Air Terminal Builder requires that you download and install the current X Builder Framework and
the AutoDesk VoloView Express® programs. Both of these can be downloaded from the E-CAT download table on
the internet site. VoloView Express® (copyright Autodesk, Inc.) is freely distributed by AutoDesk Inc., as its
drawing viewer. Any redistribution of VoloView Express® must be in compliance with the Software License
Agreement which is displayed during the VoloView Express® installation.

PREVIOUS VERSION INFORMATION

1. Air Terminal Builder v1.09d replaces v1.09c when it is installed. Therefore, it is not necessary to uninstall
v1.09c before installing v1.09d.

2. Existing projects created with Air Terminal Buillder v1.09c can be used immediately in v1.09d, but they will
initially contain only invalid tags. To quickly make all tags valid in the new version, highlight the project name
in the projects tree on the left and then click the “Update All Tags” button which appears at the bottom of the
right hand pane.
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SPECIAL NOTES

1. X-Builder Framework. The current version of XBuilder Framework should be installed before installing Air
Terminal Builder.

4. Chilled Beams can now be configured and ordered through the Air Terminal Builder. Performance calculations
are not yet available in the Builder. Please contact your Carrier sales office for performance calculation data.

5. Adobe Acrobat. Adobe Acrobat Reader v4.05 or later is required to view certified drawings. If this software
has not yet been installed on your computer, download the latest version of Adobe Acrobat Reader from
www.adobe.com/products/acrobat and install it.

6. VoloView. VoloView v2000-129 or later is required to view CAD templates from within Commercial Split
Systems Builder. If this software has not yet been installed on your computer, you can do so by running
Windows Explorer, navigating to the \VOLO_NEW folder on the E-CAT CD and then double-clicking on the
VVE2SETUP.EXE file. Note that if you do not intend to view templates within Commercial Split Systems
Builder, this software is not needed. Many users display template drawings using a CAD system such as
AutoCAD instead.
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Commercial Split Systems Builder v1.18 replaces v1.17 

UPDATE DESCRIPTION 

Commercial Split Systems Builder v1.18 includes the following changes: 
 Updated factory installed options and accessories for 38AP outdoor units. 
 Added AeroAcoustic condenser fans and low-sound compressor blankets as accessories.  These items were 

formerly factory installed options. 
 Added wind baffles as accessories. 
 Added factory installed options and accessory items for security grilles / hail guards.  

In addition the following problem was corrected: 
 The Performance Report for 38AUD outdoor unit sizes 12 and 14 did not display electrical data. 

INSTALLATION PROCEDURES 

Installation via Internet Download 

To perform a full program install, please use the following procedure: 
 Download the ecat-csb118.exe file from the Internet site and save it in a folder on your hard disk. 
 Run Windows Explorer and double-click on the ecat-csb118.exe  file.  This launches the program installer. 
 Follow the installation instructions which appear on your screen. 
 Note: AutoDesk VoloView Express® and the latest X Builder Framework should be installed prior to installing 

the Commercial Split Systems Builder.  Both can be downloaded from the internet site.  

Running the Program 
Carrier Electronic Catalog can be used to launch Commercial Split Systems Builder.  To start Electronic Catalog: 
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs. 
 In the Carrier E-CAT and E20-II Programs group choose the Carrier Electronic Catalog item.  From Electronic 

Catalog you can create new or edit existing tags via the Project tab, or you can directly launch the program via 
the Programs tab. 

Minimum Computer Requirements: 

 Hard Disk Space: Up to 50 megabytes 
 Random Access Memory: At least 64 megabytes 
 Display Monitor: At least VGA with 600x800 resolution and 256 colors. 
 Operating System: Windows 98, 2000, XP, Vista or Windows NT (with service pack 4 or later). 
 The latest XBuilder Framework should be installed prior to installing the Commercial Split Systems Builder. 
 Autodesk Volo View Express® 

Please note that Commercial Split Systems Builder requires that you download and install X Builder Framework and 
the AutoDesk VoloView Express® v2000-129 programs.  Both of these can be downloaded from the E-CAT 
download table on the internet site.  VoloView Express® (copyright Autodesk, Inc.) is freely distributed by 
AutoDesk Inc., as its drawing viewer.  Any redistribution of VoloView Express® must be in compliance with the 
Software License Agreement which is displayed during the VoloView Express® installation. 
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PREVIOUS VERSION INFORMATION 

1. Commercial Split Systems Builder v1.18 will replace v1.17 automatically.  It is not necessary to uninstall v1.17 
before installing v1.18.  

2. Existing projects created with Commercial Split Systems Builder v1.17 can be used immediately in v1.18, but 
they will initially contain only invalid tags.  To quickly make all tags valid in the new version, highlight the 
project name in the projects tree on the left and then click the “Update All Tags” button which appears at the 
bottom of the right hand pane. 

SPECIAL NOTES 

1. XBuilder.  The latest version of XBuilder Framework should be installed before installing Commercial Split 
Systems Builder. 

2. Adobe Acrobat.  Adobe Acrobat Reader v4.05 or later is required to view certified drawings.  If Acrobat Reader 
is not yet installed on your computer, the latest version can be downloaded from 
www.adobe.com/products/acrobat and then installed. 

http://www.adobe.com/products/acrobat


Fan Coil Builder

v3.31
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Fan Coil Builder v3.31 replaces v3.30 

UPDATE DESCRIPTION 

Fan Coil Builder v3.31 includes the following changes: 
 Added DX coil systems as a quick ship option for 42B models. 
 Removed obsolete items from the product library.  

In addition, the following problems were corrected: 
 Certain 42S models incorrectly allowed risers.  Other 42S models incorrectly disallowed risers. 
 Certain factory installed options were displayed twice on the Unit Report - once with the base description and a 

second time with the required FIOP code.  The report has been revised to show each selected FIOP only once to 
avoid confusion.  

 If the Print button on the Performance tacb was clicked, the printed report contained solid black pages.  Report 
content was unreadable. 

INSTALLATION PROCEDURES 

Installation via Internet Download 

Use the following procedure to install the program: 
 Download the ecat-fcb331.exe file from the Internet site and save it in a folder on your hard disk. 
 Run Windows Explorer and double-click on the ecat-fcb331.exe file.  This launches the program installer. 
 Follow the installation instructions that appear on your screen. 
 Note: The current version of X Builder Framework and AutoDesk VoloView Express® should be installed prior 

to installing the Fan Coil Builder.  Both can be downloaded from the internet site. 

Running the Program 
Carrier Electronic Catalog can be used to launch Fan Coil Builder.  To start Electronic Catalog: 
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs. 
 In the Carrier E-CAT and E20-II Programs group choose the Carrier Electronic Catalog item.  From Electronic 

Catalog you can create new or edit existing fan coil tags via the Project tab, or you can directly launch the 
program via the Programs tab. 

Minimum Computer Requirements: 

 Hard Disk Space: 20 megabytes 
 Random Access Memory: At least 64 megabytes 
 Display Monitor: At least VGA with 600x800 resolution and 256 colors. 
 Operating System: Windows 98, 2000, XP, Vista or Windows NT (with service pack 4 or later). 
 The current version of XBuilder Framework should be installed prior to installing the Fan Coil Builder. 

PREVIOUS VERSION INFORMATION 

1. Fan Coil Builder v3.31 will replace v3.30 automatically.  It is not necessary to uninstall v3.30 before installing 
v3.31.  

2. Existing projects created with Fan Coil Builder v3.30 can be used immediately in v3.31, but they will initially 
contain only invalid tags.  To quickly make all tags valid in the new version, highlight the project name in the 
projects tree on the left and then click the “Update All Tags” button which appears at the bottom of the right 
hand pane. 
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PREVIOUS VERSION INFORMATION (continued) 

3. Existing projects created with Fan Coil Builder v3.29h or earlier versions can be used in v3.31, however tags in 
these projects must be converted before they can be used with v3.31.  To convert the tags, use the following 
steps: 
 Start Fan Coil Builder v3.31. 
 Choose the "Convert Project" item on the File Menu. 
 A window will appear listing all current projects that contain Fan Coil Builder v3.2 tags.  Select all projects 

whose tags you wish to convert.  Then press OK. 
 Tags in the selected projects will be converted. 
 When you are returned to the program main window, the tags are ready for use with v3.31. 

SPECIAL NOTES 

1. XBuilder.  The latest version of XBuilder Framework should be installed before installing Fan Coil Builder. 



Packaged RTU Builder

v1.19q



 February, 2010  Page 1 of 2 

 

 

Carrier Software Systems 
Syracuse, NY, USA 

1-800-253-1794 
software.systems@carrier.utc.com  

 

Carrier Electronic Catalog 

Packaged RTU Builder v1.19q 

Release Sheet 

Packaged RTU Builder v1.19q replaces v1.19p. 

UPDATE DESCRIPTION 

Packaged RTU Builder v1.19q includes the following changes: 
 Added performance rating data for the 48/50TC size 09 with dual cooling compressors 
 Added DXF templates for 48/50TC 15-25 tons. 
 Added DXF templates for the 48/50TC 12.5 tons. 
 Implemented IEER display instead of IPLV for 2010 unit models (if IEER is available) 
 Added roof curb certified drawings for the 48/50TC 15 – 25 tons. 

In addition the following problem was corrected: 
 When the performance rating calculation was requested for 48/50TC with dual compressor specified, the program 

displayed a message “Performance data for this unit is not available yet on the builder.  Please refer to product 
data.”  This error limited the selection of 48/50TC 08, 12, and 14 to single compressor models only. 

 Pressure drop for certain electric heater sizes was not considered when calculating total external static. 

INSTALLATION PROCEDURES 

Installation via Internet Download 

To perform a full program install, please use the following procedure: 
 Download the ecat-prb119q.exe file from the Internet site and save it in a folder on your hard disk. 
 Run Windows Explorer and double-click on the ecat-prb119q.exe  file.  This launches the program installer. 
 Follow the installation instructions which appear on your screen. 
 Note: AutoDesk VoloView Express® and the latest X Builder Framework should be installed prior to installing 

the Packaged RTU Builder.  Both can be downloaded from the internet site.  

Running the Program 
Carrier Electronic Catalog can be used to launch Packaged RTU Builder.  To start Electronic Catalog: 
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs. 
 In the Carrier E-CAT and E20-II Programs group choose the Carrier Electronic Catalog item.  From Electronic 

Catalog you can create new or edit existing tags via the Project tab, or you can directly launch the program via 
the Programs tab. 

Minimum Computer Requirements: 

 Hard Disk Space: 40 megabytes 
 Random Access Memory: At least 256 megabytes 
 Display Monitor: At least VGA with 600x800 resolution and 256 colors. 
 Operating System: Windows 98, 2000, XP, Vista or Windows NT (with service pack 4 or later).  
 The latest X Builder Framework should be installed prior to installing the Packaged RTU Builder.  
 AutoDesk VoloView Express® 

AutoDesk VoloView Express® and the latest X Builder Framework should be installed before running this program.  
Both can be downloaded from the internet site.  VoloView Express® (copyright Autodesk, Inc.) is freely distributed 
by AutoDesk Inc., as its drawing viewer.  Any redistribution of VoloView Express® must be in compliance with the 
Software License Agreement which is displayed during the VoloView Express® installation. 
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PREVIOUS VERSION INFORMATION 

1. Packaged RTU Builder v1.19q will replace v1.19p automatically.  It is not necessary to uninstall v1.19p before 
installing v1.19q.  

2. Existing projects created with Packaged RTU Builder v1.19p can be used immediately in v1.19q, but they will 
initially contain only invalid tags.  To quickly make all tags valid in the new version, highlight the project name 
in the projects tree on the left and then click the “Update All Tags” button which appears at the bottom of the 
right hand pane. 

SPECIAL NOTES 

1. XBuilder  The latest version of X Builder Framework should be installed before installing Packaged RTU 
Builder.  

2. AutoDesk VoloView Express® must be installed in order to view DXF template drawings in the program.  
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SCU Builder v2.09f replaces v2.09e 

PROGRAM DESCRIPTION 

SCU Builder v2.09f includes the following changes: 
 Added a "Splittable" factory installed option for all 50AH units.  This allows use of a remote condenser. 
 50AH “Splittable” FIOP now includes an Interconnecting kit and Electrical box(es). 
 50AHWC water-cooled units have been removed. 
 50AHAC blower performance updated: added supply fan RPM and BHP data. 

In addition, the following problem has been corrected:  
 Scrollbars did not correctly appear on the Performance Tab of the Builder . 

INSTALLATION PROCEDURES 

Installation via Internet Download 
To perform a full install, please use the following procedure: 
 Download the ecat-scu209f.exe file from the Internet site and save it in a folder on your hard disk. 
 Run Windows Explorer and double-click on the ecat-scu209f.exe file.  This launches the program installer. 
 Follow the installation instructions which appear on your screen. 
 Note that X Builder Framework should be installed prior to installing SCU Builder.  It can be downloaded from 

the internet site. 

Running the Program 
Use the following procedure to run the program: 
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT/E20-II programs. 
 In the Carrier E-CAT/E20-II Programs group choose Individual Product Builders.  
 In the Individual Product Builders group click on the SCU Builder v2.09f item. 

Minimum Computer Requirements: 

 Hard Disk Space: Up to 50 megabytes 
 Random Access Memory: At least 64 megabytes 
 Display Monitor: At least VGA with 600x800 resolution and 256 colors. 
 Operating System: Windows 98, 2000, XP, Vista or Windows NT (with service pack 4 or later). 
 The current X Builder Framework should be should be installed prior to installing the SCU Builder. 
 Autodesk Volo View Express® 

AutoDesk VoloView Express® and the latest X Builder Framework should be installed before running this program.  
Both can be downloaded from the internet site.  VoloView Express® (copyright Autodesk, Inc.) is freely distributed 
by AutoDesk Inc., as its drawing viewer.  Any redistribution of VoloView Express® must be in compliance with the 
Software License Agreement which is displayed during the VoloView Express® installation. 

PREVIOUS VERSION INFORMATION 

1. SCU Builder v2.09f replaces v2.09e.  It is not necessary to uninstall v2.09e before installing v2.09f. 

2. Data created with v2.09e is immediately usable in SCU Builder v2.09f.  There is no data conversion required.  
However, to make all your tags valid in v2.09f, highlight the Project name in the Projects tree and then click on 
the button “Update and Recalculate all Tags”. 
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SPECIAL NOTES 

1. X Builder.  The latest version of XBuilder Framework should be installed before installing SCU Builder. 

2. Adobe Acrobat.  Adobe Acrobat Reader v4.05 or later is required to view certified drawings.  If Acrobat Reader 
is not yet installed on your computer, the latest version can be downloaded from 
www.adobe.com/products/acrobat and then installed. 

http://www.adobe.com/products/acrobat
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